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Lack of Progress Bar — User Guide

Getting started

Lack of Progress Bar (Lopb) is a performance benchmarking tool for your software development
environment. Lopb can be used to monitor and optimize the performance of tools and
infrastructure that developers access through their Eclipse-based IDE.

To install Lopb in your Eclipse environment, see Installation. To read about how Lopb works,
see the section on Concepts. For a description of Lopb Features, see the Lopb Features
section. For examples of the types of reports that can be produced with the data provided by
Lopb, see the Reporting Cookbook section. Finally, for answers to frequently asked questions,
please refer to the FAQ.

If you have any questions about Lopb or are interested in contributing to the project, please
send us an email at support@Iopb.org .

Concepts
The following paragraphs explain some of the Eclipse functionality that Lopb relies on to gather
benchmarking information.

Jobs, JobManager, JobChangeListener

Since Eclipse version 3.0, plug-in developers are strongly encouraged to implement long-
running activities as an Eclipse background Jobs (see http://www.eclipse.org/articles/Article-
Concurrency/jobs-api.html). For example, checking a file out of a source code repository,
building from an ant script, and publishing an app to an application server should be
implemented as Eclipse background Jobs by plug-in developers.

Jobs get scheduled to run by the JobManager. The JobManager provides a callback
mechanism so that classes implementing IJobChangeListener will be notified when jobs are
scheduled, when they complete, or otherwise change execution status. The events are
instances of [JobChangeEvent.

By using this mechanism, Lopb listens for all job change events and when they occur, it records
the job identifier, a timestamp, and other job data which is later used to compute various
performance metrics. The overhead introduced by Lopb is negligible.

Joblds and Runs

When IJobChangeEvents are received by Lopb, a Jobld is computed from the Job’s class and
name. We have noticed that plug-in developers often provide a short description of the job’s
behavior instead of a name, and this is supported by Lopb. We assume that the class+name
pair forms a unique identifier for a job, and in practice so far, this assumption has held true.
Every time a job runs, Lopb keeps track of start and end time along with Jobld. When a job
ends, Lopb determines average execution time for all runs of the given Jobld, in addition to
some other metrics. This data is presented in the Lopb Report View.
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Concurrent Jobs and Scheduling Rules

Jobs can run concurrently, and may indeed contend for shared resources (e.g. workspace files).
In order to guard against resource corruption and deadlock, scheduling rules are used. At this
time, Lopb is not concerned with concurrency or scheduling rules since only individual job runs
are monitored, and not dependencies between jobs or the locks or files that they contend for.
This may change in the future in order to produce aggregate or “roll-up” metrics, see Lopb
Status indicator (experimental).

Installation

Update Manager
In order to install Lopb using the Eclipse update manager, follow the instructions here and enter
http://lopb.org/update as the Eclipse update site URL.

Show View
Upon installation for the first time, the Lopb
views will not be visible. To enable them, click Screenshot: Show View Dialog

Window > Show View > Other... .
& Show View X
From the popup dialog that appears (as shown
to the right), select the Lack of Progress Bar E:
folder and one of the two Lopb views, either = ant A
Lopb Report view or Lopb Ignored Jobs view. [= Cheat Sheets
= Cvs
[ Debug
= Help
[ Java
[= Java Browsing
== Lack of Progress Bar
O Lopb Ignored Jobs
O Lopb Report:
= FDE
[~ PDE Runtime
= 5N
[= Team
= Vex

[ 4 ] [ Cancel
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Lopb Features

The following few paragraphs describe the features provided by Lopb, including the two Eclipse
views, and the Eclipse workbench window trim contribution (i.e. Lopb Status indicator).

Lopb Report View

The Lopb Report View is the main view provided by Lopb. In the right panel, it shows a table of Jobs that
have run since the beginning of the development session, which is generally when Eclipse started. In the
left panel, a set of enabled or disabled Labels is shown. When a given label is enabled (checked), the
jobs associated with that label will appear in the table.

Screenshot: Lopb Report View

Problems | Javadoc | Declaration m ¥ =0
Labels Job Labels Runs Errors Total Time {sec) Avg Time (sec) System? | Blocking?
AMNT AnimationManager - Animation stark Eclipse Internal 3 u] 0.33 0,11 ‘fes Mo
Build AutoBuildJob - Building workspace Build z i} 2,28 4,64 Mo Mo
Eclipse Console CIeanDi‘.alog - Cleaning selecteq projects : ) Build 1 1] 1.81 1.81 Mo Mo
Eclipse Intarnal DecorationScheduler - Decoration Calculation Eclipse Internal 7 1] 1.75 0.25 es Mo
_p DecorationScheduler - Update For Decorati, .. Eclipse Internal 7 1] 1.88 0.27 es Mo
Ecl!pse Team IDEIdleHelper - Collecting garbage Eclipse Internal 1 1] 0.45 0.45 es Mo
Eclispe Internal Motify Job - Updating workspace Eclipse Internal [ il £.36 1.06 Yes Mo
SYM org. eclipse. core.internal.resources, Conte. .. Eclipse Internal | 1 | o | w4z | 74ar | wes [ Mo |
[Jvex Progressianager - Show In Dialog Eclipse Internal 1 o 0.34 0.34 Yes Mo
ProgressionitorFocusJobDialog - Close di.. Eclipse Internal 1 1] 0.08 0.08 es Mo
ProgressMonitorFacus IobDialog - Open us. .. Eclipse Internal 1 1] 0.05 0.05 Yes Mo
ProgressviewUpdater - Update Progress Eclipse Internal 25 1] 4,70 0.19 es Mo
£ ?
Lopb Report View: Columns
The Lopb Report View table columns are described below.
Column Description
Job Shows either the jobld (which is derived from the class and name of the

Job instance) or the jobAlias if one exists. This cell is editable so that
users may modify the displayed text used to identify the job (a.k.a.
JobAlias). Also see “Enable job renaming” in the Lopb Preferences page.

Labels A comma separated list of labels assigned to a Job. Similar to Gmail
labels used for organizing emails into one or many labels or categories.

Runs The number of times the job has run since the start of the session.

Errors The number of times that the job has returned an error code when it
completed.

Total time (sec) The sum of all run times, where each run time is equal to the end time

minus the start time (in seconds).

Avg Time (sec) The total time divided by the number of runs (in seconds).

System? Job property indicating whether the job was started by an internal Eclipse
system routine, or not (i.e. user-initiated).
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Blocking? Job property indicating whether this job is blocking a higher priority non-
system job from starting due to a conflicting scheduling rule.

Lopb Report View: Drop-down Menu

In the top right corner of the view, the user may click on a drop-down command menu. The
available commands are described below.

Command Description

Export to CSV Export the data from the Lopb Report View table to a comma separated
value (CSV) file. See the “Output directory for exporting CSV files”
preference in the Lopb Preferences page.

Reset session Reset the user’s session by clearing all jobs from the Lopb Report View
table and setting all timers to zero.

Lopb Report View: Right-click Menu

By selecting a row and then right-clicking, the user will be able to ignore a job from futher
processing. This means that Lopb will not collect data for any future runs of the Job.

Ignored Jobs View

Users may indicate that they want Lopb to ignore certain jobs (see Lopb Report View: Right-click Menu,
command Ignore Job). The jobs that have been ignored are displayed in the Ignored Jobs View shown
below.

Screenshot: Lopb Ignored Jobs View

Problems | Javadoc | Declaration | Loph Report [ RGeS e tere=te fa e s ] =08
Job Class Description
iorg.edlipse, core.internal utils, StringPoolJobi Compacting memary) org.eclpse.core.internal ukl,..  Compacting memory
org.eclipse,uiinternal activities, Mut ableactivityManager$2{1dentifier Update Job) org.eclipse.uiinternal activi...  Identifier Update Job
org.eclpse.jdt.internal .core, search, processing, JobManager$ 1 $ProgressJobi Java indexing in progress)  org.eclipse.jdtinternal.core...  Java indexingin pro...
org.eclipse,core.internal resources, DelayedSnapshotJobiPeriodic workspace save.) org.eclipse.coreinternal res,..  Periodic workspace ...
Lopb Ignored Jobs View: Columns
Column Description
Job The Jobld or JobAlias. Same as Lopb Report View, Job column, except the cell is
not editable.
Class The Job class.
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Description The name or description of the job.

Lopb Ignored Jobs View: Right-click Menu

By selecting an ignored job (i.e. row) in the table and then right-clicking, the user may remove a job from
the list of ignored jobs.

Lopb Status Indicator (experimental)

The Lopb Status Indicator is still an experimental feature. It shows an aggregate metric of how much of a
developer’s session is consumed by background jobs as a percentage. It is intended to be used as a
benchmark indicator for system deltas, or rather to compare system performance before and after a
change like a RAM upgrade or system reconfiguration.

Screenshot: Lopb Status Indicator

o om 125 (26%) ()

The Lopb Status Indicator is eventually going to be the “lack of progress bar”, so the more time
developers wait for jobs to complete (by staring at a progress bar), the higher the “lack of progress”
metric will rise, and vice versa.

This indicator is disabled by default, but it may be enabled by clicking the Lopb status checkbox on the
Lopb Preference page.

Preferences
The user may override certain default behavior for Lopb by changing settings in the Lopb Preferences
page. To access the page, click Window > Preferences and then select Lack of Progress Bar (Lopb).
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Screenshot: Lopb Preference Page

& Preferences

| type Filter text | Lack of Progress Bar (Loph) =l
General Preferences For the Lack of Progress Bar plugin.
Ant [¥] trclude system job
Help nclude system jobs
Install/lUpdate [¥] Enable job renaming
Java - . . Qutput directory For exporting CSY files |C:'I,DOCLIMEN1'I,aIex'l,LOC.ﬂLSml'l,Temp'l,Inph | [ Browse, ..
Lack of Progress Bar (Lopb)
Flug-in Development [15how Lopb status (Caveat: this contral is stil expetimental!)
Run/Debug
Team
[Restnre Defaults] [ Apply l
@ [ (04 ] [ Cancel ]
The preferences that can be modified are described below.
Preference Description
Include system jobs When checked, system jobs will be monitored by

Lopb; otherwise they will be ignored.

Enable job renaming When checked, Job alias will be editable (first column)
in the Lopb Report view.

Output directory for exporting CSV files | When exporting CSV files, this is the base directory
for all output files.

Show Lopb status When checked, the Lopb status indicator will be
shown in the Eclipse workbench window trim.
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Reporting Cookbook

This section describes various reports that can be produced from the data collected by Lopb. At this
time, Lopb does not have any built-in reporting functionality. The data is exported from Lopb as CSV
files, and then processed using a spreadsheet tool like MS-Excel in order to produce these reports.

Report Example 1: Comparing Job run times before VS after a system upgrade

Let us assume that Lopb was used to collect data about how long it took to check-in files on average for
a given developer over the course of a week. Then, after an upgrade to the source code repository
server, data was collected again over the course of a second week. Finally, by plotting the average time
it took to check in a file for each of the week, the following report is produced.

Comparison of Clearcase Checkins

-

[ (before/after upgrade)

9

2 25

2 15 — ——\Week 1
> — S = Week 2
5 TT—.——

£ 05

=

E O I I T

<C Mon Tues Wed Thurs Fri

Day of Week

TODO: add more reporting examples

FAQ

1. Does it slow down my IDE?

The overhead introduced by Lopb is negligible. We were careful to not do any time-
consuming processing in the JobManager of IJobChangeListener callback handlers. We
don’t yet have a factor for the overhead, but through a lot of experimentation, we have
seen that it is very small.

2. lIsitfree?

Page 8



Lack of Progress Bar — User Guide

Yes. Lopb is released under the terms of the Eclipse Public License, version 1.0 and
your are free to download and use the software. For further details on what you can or
cannot do, please read http://www.eclipse.org/legal/epl-v10.html. Note that the EPL is a
permissive, non-viral open-source license unlike the GPL.

TODO: add more guestions as they get asked

Further Reading
We highly recommend Eclipse Plug-ins, 3™ Edition, by Clayberg and Rubel for developers
interested in building Eclispe plug-ins. We couldn’t have built Lopb without it.

Page 9


http://www.eclipse.org/legal/epl-v10.html

